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Office 365 UCWA Configuration

Prerequsite
- A Microsoft Office account that has access to Skype Online P2
- Activate license Skype integration on Flexi user
- Public FQDN to Flexi server
- Server need internet access

Limitations
- Flexi will only read data from Skype Online
- Will not affect line status in Flexi, due to inconsistent behavior on presence state in Skype.
Data will be treated as Skype user information data.

Register your application with Azure AD
Sign in to the Azure Management Portal, then do the following:

1. Loginto to https://aad.portal.azure.com as administrator
2. Select “Azure Active Directory” and then “App registrations”
3. Add an app “New application registration”

Azure Active Directory admin center

« Dashboard > Datatal AB - App registrations

[E pashboard Datatal AB - App registrations
Azure Active Directory
‘= All services
O Search (Ctri+) « I =+ New application registration |:E Endpoints A Troubleshoot
FAVORITES
- . o o o . - 4’ The preview experience for App registrations is available. Click this banner to la
B Enterprise applications verview

(> Azure Active Directory i’ Getting started Search by name or AppiD My apps A

DISPLAY NAME

M Users Manage

= . q

&2 App registrations pa Users
- Groups

BS Organizational relationships
24 Roles and administrators
5 Enterprise applications

. Devices

B App registrations

Enter Name a unige name for this app like “PresentityUCWAConnector”

Select Application type Native

On Redirect URI set Fel! Ogiltig hyperlankreferens.

Click create

Select Settings -> Require premissions -> Add -> Select an API -> Skype for Business Online
. Click Select

10. Check Read/Write Skype user information

11. Check Read/Write Skype user contact and groups

12. Click Select

©® N U e
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https://aad.portal.azure.com/

Add API access X Enable Access

Select an API
1 . : v E| DELEGATED PERMISSIONS REQUIRES ADMIN
Skype for Business Cnline
Initiate conversations and join meetings @ No
2 Select permissions > Create Skype Meetings @ No
0 role, 2 scopes
I +  Read/write Skype user information (preview) @ No I
Receive conversation invites (preview) @ No
+ | Read/write Skype user contacts and groups @ No

13. Click Done
14. Click Grant premissions

Required permissions O

+ Add | ™ Grant permissions

Do you want to grant the permissions below for PresentityUCWAConnector for all
accounts in current directory? This action will update any existing permissions this
application already has to match what is listed below.

]

15. Copy Application ID notepad, needed when configure Flexi Presentity

PresentityUCWAConnector x X

Registered app

'u' Settings ." Manifest

Display name Application ID
PresentityUCWAConnector 0f391d41-7e6c-49d7-8737 [

Application type Object ID
Native 59947b34-d277-4466-b545-31765d9459¢e5
Home page Managed application in local directory

--- PresentityUCWAConnector

»
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Sign in to Admital web
1. Make sure that you logon as sysop accessright. Need access to System tab

Admin

System load
Dynamic fields
Gateway

Calendar integration

Directory Service

Skype integration

Active connections

Rules

Servers

UCWA Servers I

N

Click New Server...

Enter username and passhrase for a the Skype account that Presentity should use. User must
be a valid Skype user.

Enter Client ID, user Application ID from above

AD instance, enter https://login.microsoftonline.com/

In Domain, enter customers domain

In Tennant, enter customers tennant domain.

System / Skype integration / UCWA Servers / Edit

Username: -@datatal.se

Passphrase: sesssrnnten

Client ID: 0f391d41-7e6c-49d7-8737 ]

AD instance:  https://login.microsoftonline.com/

Nous

Domain: datatal.se

Tennant: datatal365.onmicrosoft.com

m Cancel Delete Apply

8. Goto System->Skype integration->Rules

9. Click New

10. Select [UCWA] Host, this is the created host above

11. Enter a rule, example %@datatal.se this will match all users on @datatal.se

12. Enter a priority, enter 1 if no other rules are needed
System / Skype integration / Rules

Host: [UCWA] datatal365.onmicrosoft.com v

Rule: [%@datatal.se ]

Priority: | 1

m Cancel Delete Apply
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https://login.microsoftonline.com/
mailto:%25@datatal.se

Trobleshooting UCWA integration
Goto UCWA server in Admital, check status text column. Example below is everything okay

New server...

AD Instance Domain Status | Status text

datatal365.onmicrosoft.com  https://login.microsoftonline.com/ datatal.se || 1 Connected

- Check that, username and password is correct entered
- Check that Client ID is the same as application ID on app in Azure AD
- On Flexi server goto x:\flexi\log\lyncconnector
o Check error.log and warning.log
o Check ucwa.log and ucwaclient.log
- Check internet access, firewall setting that blocks communication
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Skype onpremise configuration

Prerequsite on Flexi server
- Flexi license for Skype connection

- Windows Server 2008 R2 SP1 or Windows Server 2012

- Windows Server 2012: Media Foundation server feature

- Windows Server 2008 R2 SP1: Desktop Experience server feature
- x64

- .NET 4.5

- UCMA 4.0 Runtime

Start Powershell on Flexi server and run...
Windows 2012

Install-WindowsFeature server-media-foundation

ey Administrator: Windows PowerShell

indows Fowershe
Copyright (C) 201% Microsoft Corporation. All rights reserved.

PS Ci\lUsers‘\Administrator> Install-WindowsFeature server-media-foundation
Success Restart Meeded Exit Code Feature Result

True Yes SuccessRest... {Media Foundation}
JJARHING: You must restart this server to finish the installation process.

PS CiilUsersM\Administrator> _

Windows 2008 R2 SP1

Import-module servermanager

Add-WindowsFeature Desktop-Experience

If reboot is require after installation of Media Foundation or Desktop Experience, do so

In Flexi installer GUI start the installation of UCMA 4.0 runtime

. UcmaRuntimeSetup.exe 2015-10-08 10:04 Application

245 B73 KB
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Skype Server settings
On Skype server

Start Powershell manager for Skype...

istrator: Skype for Business Server Management Shell

Modules For Skype for Business Server 2B15...
PS C:\Userssmegaman> _

Get-CsSite

PSS C-sUseprssmegaman» Get—Cz3ite

Identity
Siteld
Services

Pools
FederationRoute

AmppFederationRoute
DefaultPerziszstentChatPool
Dezcription

DisplayMame

SiteType

ParentSite

PS C:oslsepssmegaman

Sitecvishy

i
{CentralManagem
teway:johnny.de
{1lync.datatal.s
EdgeServer:lync

Site for Datata
vishy
CentralSite




Run this command...

New-CsTrustedApplicationPool -Identity flexi-Presentity.datatal.se -Registrar lync2013.datatal.se -Site
visby -ComputerFqdn inhouse.datatal.se

Identity = Trusted Application Pool
Registrar = Skype servers full FQDN
Site = Skype site name, from previous step

ComputerFgdn = Flexi server name FQDN

rator: Skype for Business Server Management Shel
Lnadlng Modules for Skype for Business Server 2815
g \U..ell's\meganan) New—CsTrustedApplicationPool *Identlty flexi-Presentity.datatal.se —Registrar lync2@13.datatal.se —Site vishy —ComputerFgdn inhou
_»E atatal.se
RNING: The Following changes must be made in order For the operation to be complete.
Enable—CsTopology must still be »un for all changes to take effect.

1-ExternalServer—
Regl.,trar.lynczﬂlfi datatal.se

True
: True
: False
: True

ngPortStart
ngPortCount
UideoPortStart
UideoPortCGount
Applications
DependentServiceList
Serviceld 1-ExternalServer-2
Siteld : Sitezvishy
Poo 1Fgdn : flexi-Presentity.datatal.se
Uersion :
Ro 1e : TrustedApplicationPool

PS C:Users'megaman’

Create application ID and bind a port

New-CsTrustedApplication -Applicationld urn:application:Presentity -TrustedApplicationPoolFqdn
flexi-Presentity.datatal.se -Port 6001

Applicationld = urn:application:Presentity

Port = 6001

False
True

alServer—2
8i ishy
flexi-Presentity.datatal.se
TrustedApplicationPool

PS C:Users\megaman> New—CsTrustedfpplication —Applicationld uen:application:Presentity —TrustedApplicationPoolFgdn flexi-Presentity.datatal.se —Port

6001
UARNING: The following changes must be made in order for the operation to be complete.
Enable—CsTopology must still be run for all changes to take effect.

Identity flexi-Presentity.datatal.sesurn:application:presentit
ComputerGruus {inhouse .datatal.se sip:inhouse.datatal.sefdatatal.se;gruu;opague=srur:presentity:p?nfnBAEV1KN4rEJsiNcPuAR}
piflexi-Presentity.datatal.sePdatatal.se;gruuiopaque =sruripresent ity:xJjHOwHKY 1IC5DpPmANYyeAAA
Mtls
urn:application:ipresentity
TrustedApplicationPoolFgdn : Flexi-Presentity.datatal.se
6081
LegacyApplicationName presentity




After New-CsTrustedApplicationPool and New-CsTrustedApplication run Enable-CsTopology to
enable config changes.

Enable-CsTopology

alServer—2

vishy
flexi-—Presentity.datatal.se

TrustedApplicationPool

PS C:\Users\megaman> New—CsTrustedApplication —Applicationld uen:application:Presentity -TrustedApplicationPoolPgdn flexi-Presentity.datatal.se —Port

LARNING: The following changes must be made in order for the operation to be complete.
Enable—CsTopology must still be »un for all changes to take effect.

: flexi-Presentity.datatal.se/urnzapplicationipresentit
5 {1n]|nu‘.e datatal.se sip:inhouse. datatal sefdatatal.se;gruu;opague=srvr:presentity: p?nfnBdEV1KN4rXJs iNc?uAR}
lexi—Presentity.datatal.sefdatatal.se jgruujopagqu ruripresentityxJjHOuHKY 1G5DpPnANYyenAn
Htl..

urnzapplication:presentity
TrustedApplicationPoolFgdn : flexi-Presentity.datatal.se
Port 6801
LegacyApplicationName presentity

Service GRUU is needed for Flexi to communicate with Skype server. To receive that run this
command, and copy it from console Window and save it to later use in a text file.

Get-CsTrustedApplication -Identity flexi-Presentity.datatal.se/urn:application:presentity

g Select Administrator: Skype for Business Server Management Shell

Mave
Size egaman> New—CsTrustedApplication —Applicationld urnzapplication:Presentity —TrustedApplicationPoolFgdn flexi—Presentity.datatal.se —Port

—  Minimize: Following changes must be made in order for the operation to be complete.
O m logy must still be run for all changes to take effect.
aximize:
X Close flexi-Presentity.datatal.se/urnzapplication:presentity
N rark {inhouse.datatal.se sip:inhouse.datatal.se@datatal.se:gruu;opagque=srur:present ity :p?nfnBdEUV1KN4rYJsiNcPwARY
sip:flexi—Presentity.datatal.seBdatatal.se;gruu;opagus e 2 PR xJ jHOWHKY 1C5 DpPnANYyeARA
Defaults Copy Enter Mtls

Properties urn:application:presentity
L= flexi-Presentity.datatal.ce
Select Al o

Serall presentity
Find...

Identity

ComputerGruus nl\ﬂ ta Bdatat. ?mf nBAEU 1KN4pR Js iNcFwARY
ServiceGruu D) LyeAnn)

Protocol

ApplicationId pplication:presentity

TrustedfApplicationPoolFydn Flexl—Pre.,ent1ty.datatal.ae

0Bt @81

LegacyApplicationName pre_‘ent).ty

Users megaman >

Later you will need to create a certificate on the Skype server, so be sure that you still have access
toit.



Flexi server Settings
Now login to Admital and create a Lync server and fill these settings. Be careful that all settings are
case sensitive!! Log in as sysop

Admital->System->Lync integration->Servers
New...

Host : Skype server FQDN

Port: 5061

URI: sip:<flexiserverFQDN>

ServicePort: 6001

GRUU: <paste it from previous step>

m System / Lync integration / Servers

Index
User

Host: Iync2013 datatal se |
Call Center
Company Port: 5061 |
Interception Uri: ‘sipinhouse datatal se |
Queue/transfer )

. ServicePort: 6001 |

Greetings
Menu GRUU: |si pflexi-Presentity datatal se@datatal .se;gmu;upaque=sm‘.p|
Voice mail Certificate: “ |
Schedule

Serial number:
Entry point | |
Statistics
search m Cancel Delete Apply

Time booking

System

Admin

System load

Dynamic fields

Calendar integration

Lync integration

Active connections

Rules

Servers p

Save
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sip:%3cflexiserverFQDN

Rule

New..

Select host server

Rule: enter domain that can access skype service

Priority: a value within 0-10

Index

Messages

User

Call Center

Company

Interception

Queue/transfer

Host:
Rule:

Priority:

| lync2013.datatal.se ~ |

|@datatal.se

Greetings

Menu

Voice mail

Schedule

Entry point

Statistics

Search

Time booking

System

Admin

System load

Dynamic fields

Calendar integration

Lync integration

Active connections

Rules p

Servers

Accessnumber

Log out

m Cancel Apply
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Certificate create on Skype server
We need to create a certificate for communication between Skype server and Flexi server. To create
this, follow these steps. Its required!

On Skype server Start —> MMC

Certificate

Programs (1)

B= mimc

=
' Gee more resulks

Immu:| B4 Logoff |»
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File -> Add/Remove Snap-in

= Consolel - [Console Root]

3

File Action  Wiew  Favorites

T
Qopen...
Save
Save hs...

Falle |

CErlH-M
ChrlHD
Crl+5

Window  Hel

Add/Remove Snap-in...

Cpkions. ..

kel

1 Ciwindows!system3zt gpedit

2 Chwindowstsystemn3z2 services
3 Chwindowstsystern 32 staresxpl
4 Chwindowst, 1\ ServerManager

Exit

Add Certificates...

Add or Remove Snap-ins

‘fou can select snap-ins For this consaole from those available on wour computer and configure the selected set of snap-ins, Far
extensible snap-ins, wou can configure which extensions are enabled.

Available snap-ins:

Snap-in | Vendor

[~

Descripkion:

%.ﬁ.ctive Cirectory Do.., Microsoft Car, .,
[pe Active Directory Site...  Microsoft Car, ..
: fctive Directory Use, ., Microsoft Cor,

= Bckives Conkral Microsoft Cor, ..
2 aDs1 Edit Microsoft Cor,
.ﬂ.uthu:urization Manager  Microsoft Cor, .,

Certificakbes Microsoft Car. ..
o Zompanent Services Microsoft Car. ..
E‘.Ccnmputer Managem... Microsoft Cor..,

ﬁDevice Manager Microsaft Car,.,
5= Disk Management Microsoft and..,
E Ewent Viewet Micrasaft Car, .,

| Folder Microsoft Car,..

[ Grouo Policy Obieck .., Microsoft Cor,,,

=

Add = |

The Certificates snap-in allows ywou ko browse the contents of the certificate stores for vourself, a service, or a computer,

Selected snap-ins:
[l console Root Edit Extensions. .. |
Remove |
[Mowe g |
[Mowe Down |
Advanced. ..
Ok I Cancel
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Choose “Computer account”

Wllﬂll{ﬂﬁﬁﬂil-l

[]
Certificates snap-in | x|

of snap-ins, For
1
Thiz gnap-in will always manage certificates for:
!
= My user account
2 Edit Extensions. .. |
i~ Semvice account
& Computer account HEMoXE |
[ove U |
[Mowe Do |
Advanced...
[
< Back I Pt > I Cancel |
a compuker,

(0]4 | Cancel

Choose “Local computer”

Select Computer [ x|

of snap-ins. For

Select the computer you want this snap-in to manage.
!

— Thizs snap-in will alwayps manage:
& ¥ E Edit Extensions. .. |

&+ Local computer: [the computer this congole is mnning o)

" Another computer: I Browse... |

[~ &llow the selected computer ta be changed when launching from the command line. This [Matte Up |
only appliez if pou zave the conzole.

Rermove |

Mawe e |

Advanced. ..

[
< Back I Finizh I Cancel |
r a compuker,

(04 | Cancel
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Verify that Certificates is selected and press ok

Add or Remove Snap-ins E

You can select snap-ins Faor this consale Fram those available on your computer and configure the selected sek of snap-ins. For
extensible snap-ins, wou can configure which extensions are enabled.

Available snap-ins: Selecked snap-ins:
3nap-in | Wendor | - [ consale Raot Edit Extensions. .. |
%.ﬁ.ctive Directory Do,,.  Microsoft Cor,.. ECertiFicates {Local Computer)
E[;_!F\ctive Directory Sike... Microsoft Cor... Feinyz |
: Active Directory Use...  Microsaft Cor.,..
'E_".C\ctivex Control Microsoft Car... | | Move Up |
& AD3I Edit Microsoft Cor...
.ﬁ.uthnrizatinn Manager Microsoft Cor. ., Mave Down |
.Certificates Microsoft Car...
8y Component Services Micrasaft Cor..,
Ll_‘,'(:omputer Managem... Microsoft Cor..,,
%Device Manager Microsoft Cor...
(=4 Disk Managerment Micrasoft and. ..
E Event Viewer Microsoft Car...
~IFolder Microsoft Car...
[ Grouo Policy Obiect .., Microsoft Cor,., j PRI o,
Descripkion:
The Certificates snap-in allows vou to browse the contents of the certificate stares for vourself, a service, or a computer,

oK Zancel

Browse to Certificates->Personal->Certificates

File  Action “iew Favorites Window  Help

&= |zzalc= Hie

| Consale Rioot | Is
= ﬂ Certificates (Local Computer) ‘LEE
E i

| Enterprise Trust

| Intermediate Certification &uthorities

| Trusted Publishers

| Unkrusted Certificates

| Third-Party Root Certification Autharities
| Trusted People

| Remnote Deskkop

| Certificate Enrollment Requests

| Smark Card Trusked Rooks

| Trusted Devices

2 1 2 R 2 R R R R R R
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Left click in the white space and All Task->Request New Certificate...

&l Tasks Request Mey

Import. ..
Refresh :

Expork List. .. Advanced Operations k

Yiew L

arrange Icons
Line up Icons

Help

Click Next...

I Certificate Enrollment =]

;| Cettificate Enrollment

Before You Begin

The Following steps will help wou install certificates, which are digital credentials used to connect to wireless networks,
prokect conkent, establish identity, and do other security-related tasks,

Befaore requesting a certificate, verify the Fallowing:

Your computer is connected ko the network
¥ou have credentials that can be used to verify wour right ko obtain the certificate

Learn mare about digikal certificates

Mexk I Zancel
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Click Next...

I Certificate Enroliment

=] B3

=] Certificate Enrollment

Select Certificate Enrollment Policy

Certificate enrollment policy enables enroliment For certificates based on predefined certificate templates, Certificate
enrollment policy may already be configured For you.

Configured by your administrator

Enrollment Policy

Configured by you Add Mew

Learn more about certificate enrollment polic

Mext I Cancel

Choose, Webserver V2 and click on the link that says “More information is required for this
certificate. Click here to configure settings”

I Certificate Enrollment

IM[=] E3

) Certificate Enrollment

Request Certificates

You can request the Following types of certificates, Select the certificates wou want to request, and then click Enroll,

Active Directory Enrollment Policy

[~ Computer jrj STATUS: Available Details (%)

[~ RemoteDesktopComputer jg STATUS: Available Details (%)
L\, More information is required to enroll For this certificate, Click here bo configure setkings,

[V 'Web Server V2 (Windows 20030 L STATUS: Avalable Details ()

L\. Maore information is reguired ko enraoll For this certificate, Click here bo configure setkings.

[~ Show all templates

Learn more about certificates

Enirall I Cancel

sida 17



In Type enter common name, in this case its TrustedApplication pool FQDN

In this example its “CN = flexi-Presentity.datatal.se” and click add>

B Certificate Enrollment _ O]

|| Certificate Enrollment

Certificate Properties |

Requ : . .
i: Subject |General I Extensions I Private kKey | Certification Authority I Signature I
¥ouc | The subject of a certificate is the user or computer to which the certificate is issued, You can nirall.
enter information about the types of subject name and alternative name values that can be used
——  inacertificate,
Al
——  Subject of certificate
[T The user or computer that is receiving the certificate Jils )
Subject name: —
r ils

Type:

|Fullon | Add > |
W Value: ils G
I h=flexi-Presentity, datatal. se —I{ RENEHE

Alternative name;
Type:
[ s IDirectDry name j

Value:

I Add = |
< Remove | Zancel |

Learn

Learn more about subject name

(] 4 I Zancel Apply
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In Alternative name change type to DNS and enter

FlexiServer name, skype server name, TrustedApplicationPoolFQDN
Inhouse.datatal.se in this case is flexiserver

flexi-Presentity.datatal.se in this case TrustedApplicationPoolFQDN

lync2013.datatal.se in this case Skype for Business server (don’t mind lync2013 it’s just a computer

name)

B Certificate Enrollment O] =]

|| Certificate Enrollment

Requ

ou C

AL
-
-

s

Learn

Certificate Propetties Ed |

_Fs Subject |General I Exkensions I Private Key I Certification &uthority I Signature I

The subject of a certificate is the user or computer ko which the certificate is issued. You can

enter information about the bypes of subject name and alternative name values that can be used

in a certificate.

Subject of certificate

The user or computer that is receiving the certificate

Subject name:

Tvpe:

[Full ou

Value:

[

Alkernative name:

Tvpe:

ons

Value:

I inhouse, datatal, s

Learn more about subject name

Add =

<= Remove

Ch=Fflexi-Presentity . datatal se

Add =

= Remove

N

Cancel

Apphy

nirall.

ils (3

ils ()

hils ()

Cancel |
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When finish press OK...

EM Certificate Enrollment M= E3
[, Certificate Enrollment
Certificate Propetties |
Requ : . .
hi:r Subject |General I Extensions I Private Key I Certification Autharity I Signature I
Youc  The subject of a certificate is the user or computer to which the certificate is issued, You can nrall,
enter information about the bypes of subject name and alternative name values that can be used
—  in acertificate,
Al
——  Subject of certificate
[T The userar compuker that is receiving the certificate il 1)
Subiect name: .
r Type: “M=flexi-Presentity.datatal. se jils
|Fulon | Add = |
Walue: £
W (5
M I = Remove | pis
Alternative name:
Type:
rs (o =]
value: lvnc2013.datatal. se
Learn e
I Add = |
< Remove | Cancel |
Learn more about subject name
(] 4 Cancel Apply
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Now press Enroll...

Certificate Enrollment

=1 B3

= Certificate Enrollment

Request Certificates

‘¥ou can request the following tvpes of certificates, Select the certificates wou want to request, and then click Enrall,

Active Directory Enrollment Policy

[~ Computer L) STATUS: Available Details (%)

[~ RemoteDesktopComputer L) STATUS: Available Details (%)
L\‘ Mare infarmation is required ko enrall For this certificate, Click here to configure sektings,

[W\Web Server Y2 (Windows 2003) L) STATUS: fvailable Details (%)

™ Show all kemplates

Learn mare about certificates

Enrall I

Cancel

Now you shall see a Status:Succeeded and a valid period, mind that this certificate must be renewed

before that period ends! Press Finish..

I Certificate Enrollment

=]
| Certificate Enrollment
Certificate Installation Results
The Following certificates have been enrolled and installed on this computer,
Active Directory Enrollment Policy
[ web Server Y2 (Windows 2003) W STATUS: Succeeded Details &

The following options describe the uses and validity period that apply to this tvpe of certificate:
Key usage: Digital signature
Key encipherment
Application policies:  Server Authentication

Walidity period (days): 730

\iew Certificate |

Now in the MMC GUI you shall see an active certificate that can be exported. Next step export...

ol flexi-Presentity, datatal. se

L=

Datatal Certification Authority 2017-10-06

Server Authentication
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Export certificate from Skype server

Right click on the new certificate, all tasks->export...

Dratatal Certification Authority

Eillynczo  OpEN Datatal Certification Authority

Open
Cut Request Certificate with Mew Key...
Copy Renew Certificate with Mew Eey,.,
Delete ]

Manage Privake Kevs, ..
Propetties Advanced Operations 3

Help

Click Next...

Certificate Export Wizard r

Welcome to the Certificate Export
Wizard

This wizard helps wou copy certificates, certificate krusk
lists and certificate revocation lisks from a certificate
skare ko yaour disk,

& certificate, which is issued by a certification autharity, is
a confirmation of wour identity and contains infarmation
used to prokect data or to establish secure network,
connections, & certificate skore is the swstem area where
certificates are kept,

To continue, click Mesxk,

< Back

Cancel |
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Export with private key... click Next...

Certificate Export Wizard I

Export Private Key
You can choose ko export the private key with the certificate,

Private kevs are passwoard protected, IF wou want bo export the private key with the
certificate, vou musk bype a password on a later page,

Do you wank to export the private key with the certificate?
¥ ‘es, export the private key

" Mo, do not export the private key

Learn mare abouk exporking private kewvs

< Back I Mext = I Zancel
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Click Next...
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Enter a Password and remember it, will be needed when import on Flexi Server. Click Next...

Certificate Export Wizard r

Password
To maintain security, wou must protect the private key by using a password.

Type and confirm a passwaord.

Password;

Type and confirm passwaord {mandator:

< Back I Mexk = I Cancel
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Enter a filename... Click Next...

Certificate Export Wizard X I'

File to Export
Specify the name of the File you wank to export -

File name;

CiisersimegarmanDocurnentsiFlexi-presentity-lynoCert, pFx Browse. .. |

T

T

Zancel |

< Back
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Click Finish...

Certificate Export Wizard

Completing the Certificate Export
Wizard

ou have successfully completed the Certificate Export
wizard,

You have specified the Following settings:

File Marne
Export Keys Yes

Include all certificates in the certification path Mo
File Format Person.

1| | 1

< Back I Finish I Zancel

T

T

Certificate Export Wizard [E3 |

The export was successful,

Browse to the file where it was

Mame =

exported to and copy the file to FlexiServer...

| Tvpe | Date modified

_ﬁ flexi-presentity-lyncCert

Personal Information Exchange 2015-10-07 11:44
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Certificate import on Flexi server
On the Flexi server

Start->MMC

Programs 1}

Fgs mmc

Pt
- 5ee mare results

Immc| Lag off Pl

I | = I — '-'".=\I - I i ""'"lI P

File->Add/Remove Snap-in
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= Consolel - [Console Root]

3

File Action Wew Favorites  Window  Help

e Ctrl+M
CIpEn... CrH+0
Save Ctrl+5
Sawve As...

Add/Remove Snap-in.., Cerl+M
Options, ..

1 ServerManager
2 devmgmk

3 setvices

4 comprngrik

Ezxit

Choose Certificates -> Add>

Add or Removye Snap-ins E |

‘fou can seleck snap-ins for this console from those available on your computer and configure the selected set of snap-ins. For
extensible snap-ins, vou can configure which extensions are enabled.

fvailable snap-ins: Selected snap-ins:
Snap-in | Yendor | - [ console Roat Edit Extensions. .. |
= AckiveX Control Microsoft Cor...
F\uthorizatiu:un Manager  Microsaft Cor.., Py |
.CertiFicates Microsaft Car..,
.fir,_Cu:umponent Services Microsaft Car,.. Move lp |
ﬁ&nmputer Managem... Microsoft Cor,,, =
Device Manager Micrasaft Car... [awe Do |

=5 Disk Management Microsaft and..,
E Event Viewer Microsaft Car..,

| Folder Microsaft Car,..
=] Group Policy Object ... Microsoft Cor...
S nternet Information... Microsoft Cor..,
@ IP Securiby Monitar Microsoft Cor...
@, IP Security Policy Ma... Microsoft Cor,..
= Link. ko Web Address  Microsoft Cor... LI B

Descripkion:

The Certificates snap-in allows ywou to browse the contents of the certificate stores for vourself, a service, or a computer,

(04 Cancel

Choose “Computer account” and click Next...
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Certificates snap-in

Thiz znap-in will always manage certificates for:

£ My uzer account

" Service accourt

< Back I Mest = I Cancel F
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Choose “Local computer”, click Next...

1
Select Computer r

1
Select the computer you want thiz shap-in to manage.

~ Thiz shap-in will always manage:

* Local computer: [the computer this consale is running on)

i~ Another computer; I Browwze,.. | -

[~ allow the selected computer to be changed wher launching from the command line. This
only applies if pou zave the console,

[
¢ Back I Finizh I Canicel F

Verifiy that Certificates is selected snap-in and click OK

Add or Remove Snap-ins E

‘ou can select snap-ins For this console From those available on your computer and configure the selected set of snap-ins. Far
extensible snap-ins, vou can configure which extensions are enabled,

Available snap-ins: Selected snap-ins:
Snap-in | Wendor | - | Console Root Edit Extensions. .. |
=" Actives Contral Microsaft Cor.., B Certificates (Loc: mpuker)
.C\uthorization Manager Microsaft Cor... HENDYE |
Certificates Microsoft Cor, .
.??,_Component Services Microsoft Cor... Mave Lo |
J_!:‘,Camputer Managem.., Microsoft Cor,,, —
..J:‘DIDevice Manager Microsoft Cor, . [Mote Dot |
=7 Disk Management Microsoft and. . Add = |
E Event Yiewer Microsoft Cor, .
| Folder Microsoft Cor...
d_’ Group Palicy Object ... Microsaft Cor..,,
(S nternet Information,..  Microsoft Cor,..,
@ IF Security Monitor Microsoft Cor, .
@ IP Security Palicy Ma... Microsaft Cor..,,
=/ Link to WWeb Address  Microsoft Cor... ﬂ B7EEEE o,

Descripkion:

The Certificates snap-in allows wou ko browse the contents of the certificate stares For wourself, a service, or a computer,

QK I Cancel
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Browse to Certificates->Personal->Certificates

= Consolel - [Console Root', Certificates (Local Computer),Personal’,.Céd

=% File  Acktion  Miew Favorites  Window  Help

&= 2= 8|z HE
| Console Roat
= E Certificates (Local Computer)

= [ Personal
i Certificates
T 71 Tenskad Bank Cerbificabinn fibheribiee

In the white space right click and All-Tasks->Import

A Request Mew Certificate. ..
Import. ..
rorodh

Expart List, . Advanced Operations »

View g

Arrange Icons W
Lime up Icons

Help
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Click Next...

certicate Importwizard
Welcome to the Certificate Import I
Wizard

This wizard helps vou copy certificates, certificate trust
lists, and certificate revocation lists From your disk ko a
certificate store,

A certificate, which is issued by a certification authority, is
a confirmation of your identity and contains information
used to protect data or to establish secure netwark
connections. A certificate stare is the system area where
certificates are kept.

Tao continue, click Mext.

Cancel
Browse to our copied certificate file...
Certificate Import Wizard r
File to Import |
Specify the File wou want to import. C

File name:

|| Browse. ., |

Moke: More than one certificate can be stored in a single File in the Following Formats:

T

Personal Information Exchange- PKCS #12 (.PFx, P12}
Cryphographic Message Syntax Standard- PKCS #7 Certificates { P7E)

Microsoft Serialized Certificate Store {,35T)

Learn more abouk cerkificabe File Formats

< Back I Mext = I Cancel

sida 33



Importand!! Change to Personal Information Exchange otherwise you will not see the file. Select the
certificate file that was exported from Skype server, then press Open...

=we =

9( )v‘ ~ Libraries ~ Documents + cert ~ (& [ search cent

Organize =  New Folder = - Ol @

¢ Favories Documents library
B Deskiop cert

=l Recent Places

Arrange by Folder =

Harne Date modfied Type Size:
& Downloads

A Libraries
%] Dacuments
" Music
&) Pictures

B videos

% Computer
&L Local Disk ()

€ Metwork
File name: [flexi-presentity-lyncCert | [Personal Information Exchange = |
VA
Click Next...
Certificate Import Wizard I

File to Import

Specify the file wou wank to impork,

File name:

i UsersterikiDocumentsicerth Flexi-presentity-lvncCert, pfx Browse, .. I

Moke: More than one certificate can be stored in a single file in the following Formats:
Personal Information Exchange- PECS #12 ( PFX, . P12)
Cryptographic Message Syntax Standard- PECS #7 Certificates (P7E)

Microsaft Serialized Certificate Store (55T

Learn mare abouk cerkificake File Formats

+ Back Mexk = Zancel
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Enter password that you created when exported the Certificate file, press Next...

i
Password

Ta maintain security, the private key was protected with a password.

Type the password For the private key,

Passwiord:

™| Emable strong private key protection, You will be prompted every: time the
private key is used by an application if you enable this apkion,

[ Mark this ke as exportable, This will allow you to back up or transport your
kevs at alaker time,

¥ Include all extended properties.

Learn more abouk profecting private keys

= Back I Mext = I Cancel

Verify that this import is to Certificate store: Personal, Click Next

ertificate Import Wizard r

Certificate Store

Certificate stores are system areas where certificates are kept, =

‘Windows can automatically select a certificate store, or you can specify a location For
the certificate,

™ Aukomatically select the certificate store based on the bype of certificate

{+ Place all certificates in the Following store:

Certificate store:

Personal Browse.., |

Learn more about certificate stores

= Back I Mext = I Cancel

)
i Certificate Import Wizard %] r
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Click Next...

Certificate Import Wizard I!

Completing the Certificate Import

Wizard I
|
j i The certificate will be impaorted after wou click Finish, L
f.-:_:;qf You hawve specified the Following settings:
( : Sele I Personal
Zankent PFx
File Mame CUsers\erikiDacurne

< Back I Finish I Zancel

Certificate Import Wizard |

| The import was successful,

Verify that now this certificate will appear under Personal-Certificates

) Flexi-Presentity datatal. se Diatatal Certification Authority 2017-10-06 S

sida 36



Add Certificate on Flexi Skype connector settings
Back to Flexi server and log in to Admital as sysop.

Add additional information on the server, this will specify the certificate that will be used

Information is common name that was entered with the certificate. Remember it’s case sensitive.

PTG ETETEIETS System / Lync integration / Servers

Index
User
Host: Iync2013 datatal se |

Call Center
Company Port: 5061 |
Interception Uri: ‘sipinhouse datatal se |
Queue/transfer )

: ServicePort: 6001 |
Greetings
Menu GRUU: |sip:ﬂexi—Presentity.datatﬂl.se@datatal.se;gmu;opaque=swrp|
Voice mail Certificate: CN=flexi-Presentity datatal se |
Schedule

. Serial number:

Entry point | |
Statistics
Search m Cancel Delete Apply

Time booking

System

Admin

System load

Dynamic fields

Calendar integration

Lync integration

Active connections

Rules

SErvVers p
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Goto user and activate Lync integration on user, if another address is users primary email address
then the email on user please enter it in address field next to Lync integration

VAL EIE I Bl User / Edit user

Index
User Logon
Data
Edit user » Phone Last name: Kalstram
S Links : .
Permissions : Erik
Voice mail A TS !
Save Image E-mail: erik@datatal se
Copy hot keys Extension: 017 (E
Call Center
Company: Datatal AB ¥
Company
i ¥ Calendar integration
Interception
¥ Lync integration Address:
Queue/transfer | | yncINtegration CCoIeRR:

Restart the Lync Connector

* ADakatal Flexi Conneckar

Ehnatakal Fleyi Maintrnanre Server Servire an... kA
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Goto System-Lync integration->Active connection

Verify that connection is ok, status offline is a valid state. Error could mean that some settings above
is incorrect. Verify all steps and all is case sensitive.

www.datatal.se System / Lync integration / Active connections
Index
Messages | User  |lastupdate | _  Status |
Lars Hagberg 57s Online: Away
User Tord Bjuresten im 29s Online: Away
call center Anders Molinder im 41s Online: Away
c Molle Sidotelefon im 41s Online: Away
ompany Erik Kalstrom 1m 51s Online: DoNotDisturb
Interception Anders Alyhr 1im 51s Online: DoNotDisturb
Queue/transfer Kim Herm_ansson im 51s Dnline: Away
: Magnus Sidotelefon im 52s Online: Busy
Greetings Magnus Backstrom im 52s Online: Busy
Menu System Admin im 52s Online: Busy
: _ Johnny Pettersson im 52s Online: DoNotDisturb
Voice mail Patrik Merk 1m 54s Online: DoNotDisturb
Schedule Thomas Persson 4m 12s Offline
Ent oint Robin Ahlgren 55m 13s Error: 404 Not Found
ve Marielle Cederblad 55m 13s Error: 404 Not Found
Statistics En Administrator 55m 13s Error: 404 Not Found
Search Petra Mélperg_Svensson 1h5m 32s Ofﬂine
: : Anne-Mari Geitz 1h5m 32s Offline
Time booking Goran Geitz 1h 5m 32s Offline
System
Admin
System load
Dynamic fields
Calendar integration
Lync integration
Active connections »
Rules
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Troubleshooting

On skype server powertshell run

Get-CsTrustedApplication -Identity flexi-Presentity.datatal.se/urn:application:presentity

Verify that all ServiceGruu is included when you copied from console window, could be a wise idea to
expand the width of the console windows

g "Skype for Business Server Management Shell” Properties

. Options I Font  Lapout | Colors I

YWindow Preview

— Screen Buffer Size
width: 1 S
Height: g =
~Window Size
width [150 =
Height: BE -

rWindDw F'n:nsitin:nn—|

On Flexi server, goto x:\flexi\log\LyncConnector\

Error.log contains error message that LyncConnector have catch. Communication errors with

certificates should be logged here, first log fil to check into

AEManager.log contains communication information between SkypeServer and FlexiServer. Second

file to look into
Warning.log contains warning messages

HvdClient.log contains message from Diversionamanger

TelephonyClient.log contains communication between LyncConnector and Telephony manager
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